CDM+ Notices

Professional and Personalized Communication (from within CDM+)

CDM+ Notices make it easy for you to upgrade the appearance of letter, card, and email communications with
your congregation and staff members. A powerful word-processing interface is built directly into Notices
reports throughout CDM+, so you don't need to open multiple programs to create nice layouts. Since the
Notices interface also lets you drag and drop database fields right into your text, there's no need for data
or mail merges, either. With CDM+ Notices, personalized, professional communication is suddenly simple.

This class deals with creating and formatting notices. Determining who gets a notice is covered in other classes,
include Fundamentals of CDM+ (basic searching/report setup window), Advanced Finds and Searches, and
program-specific classes, such as Membership Notices and Exports.

Where to Find Notices

Notices with word processing and data merge capabilities are found throughout CDM+, generally on the
Reports menu under Notices (with some exceptions noted below):

Membership Notices — Address or Individual Letters, Cards, and Emails

Attendance Notices - Attendance or Missing Letters, Cards, and Emails

Visitor Notices - Visitor Letters (accessed from the Visitor Letter Assignment window on the Attendance
program menu)

Contributions Notices - Giving Unit, Contribution, and Pledge Letters, Cards, and Emails; Giving Statement
(column and line) Emails and Receipts Letters under Statements/Receipts

Memorial Gifts Notices - Gifts Given Letters, Cards, and Emails
Accounting Notices - Accounts Receivable Email Invoices

Event Registration - Registration or Activity Letters, Cards, and Emails
Check-In/Check-Out Notices - Letters and Cards

Church Notices - Letter, Card, and Email (for CDM+ Regional users)

Church Position Notices - Letter, Card, and Email (for CDM+ Regional users)
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What’s Possible?

Individual Letters - Picnic Invitation

Colors, graphics, special fonts, and more!
This Address Letter Notice illustrates |
some of the ways CDM+ Notices can
change an organization’s communications.

A personalized letter is much more likely
to be read as the same letter addressed
to “Dear Parent” The addition of text
formatting and a photo further increases
its likelihood of being noticed.

We

4~ Revert

Creating Notices

Dear Individual/First Name,

hope to see you there!

Sincerely,

You're invited to attend the annual church picnic Sunday, June 23,
following the 11 o'clock service. We'll have games for the kids, chances to
sign up for outreach opportunities, and a raffle to win dinner for four ata
local restaurant.

Dress code is casual. The church will be providing pulled pork BBQ
sandwiches and baby back ribs from Barrett's Smokehouse. Please bring a
side dish or dessert to share.

@ | Font
Palett -
a Name: prig| v
procow | Sze: 14 coor: [l
Y Fc: B Z U A A,
Format ase nme
. | us
Insert
/4| Alignment and Spacing
Find
Document
Database Fields
Dictionary |,
Vit Category: Individual v
Asterisk
Undo | Attendance Barcode
Bapt. Church
Baptism Date
Redo | Baptism Day

Baptism Month
Baptism Place

Baptism Year

Birth Date

Birth Day

Birth Month

Birth Place

Birth Year

Blood Type

Cemetery

Cemetery Place

Church School Class

Church School Status

Date Entered

Date Joined the Church

Date Joined the Church Day
Date Joined the Church Month
Date Joined the Church Year
Date of First Attendance

Date of Last Attendance

Close kel save Asterisk

The example below is an Individual Letter Notice from the Membership Reports menu, but the steps apply
to any notice (letter, card, or email) in CDM+. However, be aware that your control over the final appearance
of an email is limited. Recipients’ email programs may display your email notice differently than you expect.

Begin by selecting Individual Letter Notices, either from the menu or the Welcome to CDM+ Membership

window.

& CDM+ File Edit Program [N Help Window

R WALIME eroesiprepors > |

Reports

v

Directories

Preaching Aids Reports
Media Ministry Reports

Listings and Exports

Contribution Reports
Memorial Gifts Reports
Statistics Reports

>
>
Summaries >
Labels >

>

Visitation Details >

Address Letters
Address Cards
Address Emails

Individual Letters
Individual Cards
Individual Emails

Payables Reports
Receivables Reports

Ledger Reports Visitation Selected Types

Accounting Reports
Payroll Reports

Sales Order Reports

Event Registration Reports
Roommate Reports

Check-In/Check-Out Reports

v iv|(v|v|v|(v|vyvyvivvv /vyy

CDM+ Engage Reports

You may choose an existing Letter Notice to
edit or duplicate, or you may create a new
Letter Notice.In any case, first click the Select/
Add button next to the name of the last letter
notice that was used.
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Directories

(=]

Summaries
Labels
Notices

EEE

[ NOX )
E Lol
Print Page PDF Screen

A Letter:
% Expand

/O Search

OPTIONS

)
° Report

Body:

=L
e Format

SETUP

Load/Save

I':‘ Defaults

Listings and Exports

Visitation Details

Welcome to Membership

Getting Started | Windows

Select a report type on the left and then double click a report to open it

Address Letters

Address Cards

[E] Address Emails

Individual Cards

Visitation Selected Types

[&] Individual Emails

Close

Individual Letters

Picnic Invitation

%)

Refresh

Select/Add

Dear Individual/First Name.
You're invited to attend the annual church picnic Sunday, June 23,

following the 11 o'clock service. We'll have games for the kids, chances to
sign up for outreach opportunities, and  raffle to win dinner for four ata

local restaurant.

Dress code is casual. The church will be providing pulled pork BBQ
sandwiches and baby back ribs from Barretts Smokehouse. Please bring a
side dish or dessert to share.

We hope to see you therel

2023 CDM+ Users Conference



A new window will open in which you'll see any existing notices. On this window you have the option to
choose an existing notice, add a new notice, duplicate an existing notice, rename an existing notice, or delete
an existing notice.

e0e Select Individual Letters H

Y2 e If the letter you want to send already exists
% |asc Q-

ras_ouese e s or if there is an existing letter you can edit,

Description e Count  Description ~ VMO H H H H

ol eten 2| Y] highlight its name and click Choose.

<No Category> i 2 chismasleter | | Q)

Attendance Letters. 0 Church Letterhead *o

Board 0 Picnic Invitation 2016 | ) | @

Festival Letters. i ol

Festivals i 0

Youth Group 0!

Add Notice Category Restrictions: (V)iew (M)odify (O)wned

To create a new letter notice, click the Add icon at the top left of the window.

If you want make changes to an existing notice, but not lose the original version, highlight it in the list of
Notices and click the Duplicate icon at the top of the window.

° Select Individual Letters When you choose to Add or Duplicate a
Q- . . .
notice, you will be prompted to name it.
Calnres (Drag nolicso assign) Enter a name for this letter: s Modify Access Info
™ i vhaton Give the letter a name that will help you
<No Category> Cancel

identify it when you wish to use it again. This
name does not appear on the notice itself.
Click OK.

Attendance Letters
Birthday

Board

Choir

Elders

Festival Letters

Picnic Invitation 2
Picnic Invitation 2016 | 5.

ol

Life Events
Members

The name of the new notice will be added to
the Notices list and highlighted.

0
0

0

0

0

Festivals 0
0

0

Templates 0
Vacation Bible School Let 0
0

Youth Group

Before leaving the select notice window, you may optionally set access to the new notice you have just named
and/or assign it to a category.
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Setting Access to Notices

Access to a notice in CDM+ can be restricted by the person who creates it. Administrators can change notice
ownership and delete notices under File > Administration P> Notices.

View Access

With your notice selected in the list, click on the View Access tab. This setting restricts who can see and use
this notice as you created it.

If you leave the View Access set to Default, all CDM+ users will see this notice
N . . . . . Body Modify Access ‘ Info
displayed in the Notices list and can use the notice as you created it.

Private

If you wish this notice to be Private, to only appear in the Notices list for  © euwic
you when you are logged in, click the radio button next to Private. No other seieces
users will even know this notice exists.

sody [T modity Access | info

If you click on the radio button next to Selected, you can then choose specific
users you wish to give View Access to for this notice.

Modify Access

With your notice selected in the list, click on the Modify Access tab. This setting restricts who can modify a
notice you created.

If you leave the Modify Access set to Default, all CDM+ users will be able to
make changes to the notice.

) ) ) Body | View Access ino
If you don’t want anyone else to be able to make changes to this notice, click

Private Administrator

the radio button next to Private. S
© selected Dana

If you click on the radio button next to Selected, you can then choose specific pe rees

users you wish to give Modify Access to for this notice.

Info

With a notice highlighted, click on the Info tab to view more information about this notice.

oo Select Individual Letters

+8 &7 o

Add Duplicate Rename Delete

Description ~  Count Description ~ VMO

<All> 6! Building Gift aig

<No Category> 4 christmas letter Q:

Attendance Letters 0 Church Letterhead Q:

Birthday 0 Picnic Invitation B8

Board 0 Picnic Invitation 2016 9 : 9

Church Picnics 2

Elders 0

Festival Letters 0

Festivals 0

Life Events o Category: **No Category**
Members 0 Entered: Sep 12023 1:02 PM
Templates 0 Entered By: Ruth Stokes
et L g Modified: ~ Sep 12023 1:02 PM

Youth Group Modified By:  Ruth Stokes

Owner:  Ruth Stokes.

Add Notice Category Restrictions: (V)iew (M)odify (O)wned

26-4 Notices 2023 CDM+ Users Conference



Notice Categories
« optional

« apply to all types of Notices (Letter, Card, and Email) in all CDM+ programs

Creating Notice Categories

« donein two different ways

On-the-Fly

With the Select Notice window
open, click Add Notice Category.

Enter the category name, e.g.
Children’s Dept., and click OK.

Master Coding System

» File > Master Coding System
P Codes tab

Highlight Notice Category in the list
of code types. Click the small Add
button below the list of code, type
the category name under Description,
and click Save.

You may also Edit or Delete categories
here.

Function
=
— Codes
ﬁ%ﬁ Groups
%k- User Fields

© oo

Add Duplicate Rename Delet

Catogories (Drag notice to assign) [N
pti ~  cou

Description

Elders
Festival Letters.
Festivals

Life Events

Members
Templates

Add Notice Category

Churh Picnics

Picnic Invitation b
Picnic Invitation 2016 | 4

Select Individual Letters

Category:

Entered:
Entered By:

Modified:
Modified By:

Owner:

Restrictions: (V)iew (M)odify (O)wned

+ | oty access [

**No Category**

0ct10 201912114 PM

Accountant

May 9 2022 4:11 PM
Ruth Stokes

Ruth Stokes

Cancel Choose.

Program
Address.

Al

Contribution
Event Registration
Groups

Individual

Item Category
Roommate
Shipping Category
Visitation/Pastoral
Visitor

All Code Types
Connection Types
Email Types
Event

Notice Category
Payment Type
Phone Types

Master Coding System
Notice Category Codes
7 Attendance Letters

) [Birthday

% Board

% [choir

7 Church Picnics

% Elders

) Festival Letters

% Festivals

J | Life Events.

% Members

% Templates

. Vacation Bible School Let

. Youth Group

Add Code

Details for Church Picnics
Leader(s)
Ruth Stokes|
Location
Outside Church
Area
Grossy Knoll Behind Church

Event Time

Entered Sep 120231252 PM
by Ruth Stokes

Modified Sep 12023 12:52 PM
by Ruth Stokes

Usage for Church Picnics

Not in use

= Print Close

*To enter multiple codes, press Tab to move the cursor to the next line between entries. Click Save

when finished.
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Assigning Notice Categories
+ Click on <No Category> to see which notices have not been assigned.
Existing Notices can be assigned to categories at any time. Click on <No Category> in the Categories list to

see all notices that have not been assigned to a category. To assign a notice, simply click it in the Notices list
once to highlight and drag it to the appropriate category.

[ JON Select Individual Letters * . .
= Save time by selecting
+8 &7 - ole not
Add Duplicate Rename Delete m UItI ple nOtlceS at Once
Body | View Access | Modity Access D and dragging them to a
Description ~ Count Description ~ VM O
<All> 6! Building Gift 28 Category.
<No Category> 4:  christmas letter %)
Attendance Letters 0:  Church Letterhead %)
Birthday 0 Summer Church Picnic
Board [
Choir 0
Church Picnics 2
Elders 0
Festival Letters 0
Festivals 0
Life Events 0 Category: **No Category**
Members 0 Entered: Sep 12023 1:02 PM
Templates 0 Entered By: Ruth Stokes
Vacation Bible School Let ] Modified: ~ Sep 12023 1:02 PM
Youth Group 0 Modified By: Ruth Stokes
Owner:  Ruth Stokes

New Notices automatically assign a new notice by highlighting desired the category before clicking the
Add button.

Finding Categorized Notices

Once you have assigned notices to categories, to find a particular type of notice, such as Christian Education,
click on the category at left and all assigned notices will display in alphabetical order in the list to the right.

You can always click on <All> to see all saved Notices, both assigned and not.

Tracking and Resending Notices

CDM+ provides the ability to track when and to whom notices have been sent. For email notices, under
the Body section of the Email notice window, CDM+ shows Last Sent: with the date the selected notice was
last sent.

. Type
tug 22023 255 P cmai
hug 24 2028 1238 P cout
g 242023 236 crat
hug 242023 202600 cout
Sop 192010226 1 ot |
4130 201 404 eout

B ord ¥ Youth Group special meeting 15 Results (EITITD
0o @ Mo Recipients

<ch ink.net>

ooke

& Configure Double Ciick on Recipient to see Main Record
© colapss | @ Proview not avaiabl fo Notices sent rom.
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Record windows that relate to people in CDM+ contain a Notices tab. For example, on the Notices tab

for an individual, address, or giving unit, CODM+ displays the list of notices sent with the notice type,
description, and date sent. For email notices, CDM+ also shows the name and email address of the

recipient.

To bypass saving this information for letter or card notices, check the Do Not Save Sent Information box on

the Notice window.

Each line of the Notices tab contains buttons to get more information about the notice, resend the notice,

or delete that notice line for that particular record.

From the Program menu in CDM+, you can access Sent Notice Records for the various record types. Sent
Notice Record windows contain two tabs. The Notice tab shows the description, type, and last sent date

and time for the notices. Letter notices show a thumbnail of the notice.

The Recipients tab shows the list of recipients. To resend the notice, select recipients from the list who
need to receive the notice again, and click the Resend Selected button. You can also remove the sent

notice from recipients by selecting them in the list and clicking Remove Selected.

Formatting/Editing in the Notice Editor

Either double-click the name of your notice on the select notice window
or highlight it and click the Choose button. The notice report window
will reopen with your selected notice displaying.

Click the small Change button below the Body field to open the editor
window. Click inside the window to place your cursor and begin typing.

There are two ways to style the text in the notices editor window:

1. The Formatting Palette, which opens to the right of the notice
editor window

2. The Format button (3rd from the top in the series of buttons at the
top right of the editor window)

Clicking the Format button brings up windows with options to style
the Font, Paragraph, Document, and more.

The Formatting Palette:

( ] Formatting Palette
Font

Alignment and Spacing
Document

Database Fields

“f  Category: Individual v

Attendance Barcode

Bapt. Church

Baptism Date

Baptism Day

Baptism Month

Baptism Place

Baptism Year

Birth Date

Birth Day

Birth Month

Birth Place

Birth Year

Blood Type

Cemetery

Cemetery Place

Church School Class
Church School Status

Date Entered

Date Joined the Church
Date Joined the Church Day
Date Joined the Church Month
Date Joined the Church Year
Date of First Attendance
Date of Last Attendance
Asterisk

- opens automatically with the Notice Editor Window and maintains its position to the right edge of

the notice editor when you move or re-size the editor window.

- contains sections that will be familiar to all who have used a word processing program: Font,

Alignment and Spacing, and Document.

- also has a Database Fields section, which allows the quick insertion of information from CDM+ into a
letter or other notice. The Database Fields function eliminates the need for data merges or mail merges.

- styles existing text when text is highlighted or sets defaults for text yet to be entered.

The following topics describe each section of the Formatting Palette. Remember that most of these styling
options are also available by clicking the Format button and choosing a menu item. Clicking a menu item
after clicking the Format button opens a new window with formatting options.
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Font

Choose your Fonts and Point Sizes from the drop list. All fonts installed on your computer are available for
use in CDM+ Letter Notices.

NOTE: Be aware that “special” fonts used in an Email Notice will be replaced with another font if recipients
do not have access to that same font on the computers or mobile devices where they are viewing the email.

Click on the box next to Color to display a color palette. Click the desired color. Then choose to style your
text with any of these Face options:

bold

- italicize

— underline

— superscript

- subscript

- strike-through and/or double strike-through

T T Z 5 6
H .|.I.|.;.lul.|.I.|.I.|.E.|.I.|.|.|.I.|.|.|.I.|.|.|.I.|.I.|.A.|.I.|.

Palette

] Format Font

1 /\ =y
= 7 Format
E Font: Arial n Font Size: 14 u

iy m u m Style: Bold Text Color: || Inser{
B Italic Wl Default
] Underi liBlack /O
' A NEW HOPE . Hour ore g
] W Dark Green

Strike: ABE ABE

R . [ Dark Cyan
i e a . . Wl Dark Red
] Dear Individual/First Name, Script: | Superscript [l Dark Magenta
] - Subscript [ Dark Yellow
] You're invited to attend the annual P
b following the 11 o’clock service. W
] sign up for outreach opportunitie - Revert Changes Cancel [ ok ] R‘:
4 eao

] local restaurant.
—_—

These settings can also be specified by clicking on the Format button at the side of the notice editor window
and choosing Font.
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Numbered or Bullet List

Also in the Fonts section of the
Formatting Palette are buttons
to change text to a numbered
or bullet list. The left and
right arrows next to the list
buttons adjust the indention
of the list. Click on the Format
button and choose Bullets and
Numbering... to set the style

Dear Individual/First Name,

You're invited to attend the annual church picnic Sunday, June 23,

5 following the 11 o’clock service. We'll have games for the kids, chances to
sign up for outreach opportunities, and a raffle to win dinner for four at a
local restaurant.

of a list. K

side dish or dessert to share.
We hope to see you there!

Sincerely,

Palette

Preview

Format
Insert
yel

Find

Dictionary.

Font

Name:  Arial

size: 14 |9

Fac: B Z U A’ A,
RBE ABE

Alignment and Spacing
Document
Database Fields

Bullets and Numbering

@ Revert Changes

] Dean Patterson
4 Revert Close kd save
. .
Alignment and Spacing
[ ) Formatting Palette
o B P ST A [ i | [ Porel [P S »  Font
Palette = Alignment and Spacing
b Horizontal: = ==
Preview —
Ml s, | e Line spacing: — = —
] /\ =y Spacing
— Format
1 Before:  0.00 pt  After:  0.00 pt
+. -
L] Insert
] u Left:  0.00 inch Right:  0.00 inch
4 £ First: 0.0 inch
Find
] Document
2] ko Database Fields
] - . Dictionary
Dear Individual/First Name,
] &
4 You're invited to attend the annual church picnic Sunday, June 23, Undo
b following the 11 o’clock service. We'll have games for the kids, chances to
] sign up for outreach opportunities, and a raffle to win dinner for four ata R;:O

local restaurant.

Dress code is casual. The church will be providing pulled pork BBQ

side dish or dessert to share.
1 We hope to see you there!

N Sincerely,

1 X

™~/

-

Cancel

Expand the Alignment and Spacing section of the Formatting Palette and select options there to:

- align text (left-, center-, right-, or full-justified)

- set line spacing (single, one-and-a-half, or double)

- set paragraph spacing and indents

color: [l

These same Alignment and Spacing settings can be set in the Paragraph Properties window accessed
through the Format button. Additionally, you may set tabs in the Paragraph Properties window by specifying
them numerically. Indents and tabs can be set using a ruler in the Document section of the Formatting Palette.
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Document

(] Formatting Palette
Font

Alignment and Spacing
Document

Margins

- Format Page

View

Layout: ¥

Show: PS

Database Fields

The Document section of the Formatting Palette is where you:

set margins

choose a standard paper size and orientation or a custom paper size

control how the page is displayed and the magnification of the page

choose whether or not to show rulers (the top ruler is where to set indents and tabs)

I 1 3 ) 5 6 7T
I—lll||||§|I||||||||||||||2|||||||||||||||||||||||||||||||||||lﬁ|||||||

Click the Tab icon H to change the type of tab (left-justified, right-justified, centered, decimal).
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Database Fields @ Formatting Palette

Font
This section of the Formatting Palette contains what really sets CDM+ Alignment and Spacing
Notices apart from using a word processor to send letters to your Document
congregation. Here you selectinformation found in CDM+ to insert Database Fields
. . . . 4*  category:
in your letter without the steps of exporting and data merging.
Attendance Barcode
Click on the drop list to see a Category of database fields. Select a Bapt. Chureh
Category to see a list of available fields to insert in your letter. For Bagtgsm Day
instance, place your cursor in the letter at the point you want to insert o Plare.
the name of each individual’s Sunday School Class in a letter and either ]
double-click“Sunday School Class”in the list of fields or highlightitand Dithlbs)
click on the Insert Field Icon ’jtf_": Birth Place
Birth Year
Blood Type
Cemetery

Cemetery Place

Church School Class

Church School Status

Date Entered

Date Joined the Church

Date Joined the Church Day
Date Joined the Church Month
Date Joined the Church Year
Date of First Attendance

Date of Last Attendance

Asterisk

The selected field will be added to your letter:

We're asking ol members of Adult Sunday School Closses to bring food to share
(enough for at least 8-10 people). Please note below what type of food members of
the are assigned. Alsobe sure tobring ploce
settings for your family. The church i supplying the meat and beverages, so please
cal the office or e-mail info@fce-bigeity.org ond let Ruth know how many of you
are coming.

If you click the Preview button at the side of the notice window, you will see an example of the result:

and potato salad ond baked beons, .. you get the 1dea).

We're asking ol members of Adult Sunday School Closses to bring food to share
(enahgh for at least 8-10 pecple). Please note below what type of food members of

The church iz supplying the meat and beverages, o please call the office or e-mail
info®fcc-bigeity.org and let Ruth know how many of you are coming.

Clicking the Preview button again will return you to the notice entry mode.

Inserted Database Fields may be formatted just like any other text in a notice. Highlight the field name and
choose the font, size, color, etc.

We're asking ol members of Adult Sunday School Classes tobring food to share
(enough for at least 8-10 people). Please note below what type of food members of
the Individual/Sunday School Class are assigned. Also be sure to bring place settings
for your family. The church is supplying the meot ond beveroges, so please cdll the
office or e-mail info@fce-bigeity.org and let Ruth know how many of you are

coming.
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Click the Preview button again, to see an example of the result of the formatting:

We're asking ol members of Adult Sundoy School Closses to bring food to share
(enough for at least 8-10 people). Pleose note below what type of food membe rs of

The church is supplying the meat and beverages, =o please cdll the office or e-mail
info®¥cc-bigeity.org and let Ruth know how many of you are coming.

g To avoid blank lines in addresses, use the Address Block field from the Address database field list,

instead of:

Address Line 1
Address Line 2
Address Line 3
City, State and Zip

The above format will result in a blank line in the address if any of the Address Line fields is empty.

NOTE: Some fields, such as Full Individual Name, have options that can be controlled from the Format tab

on the report window.

Date and Time

Two of the categories available in
Database Fields are Date and Time.
Choose from the formats listed to
insert the current date or time when the
notice is printed (or emailed) into the
document.

NOTE: If you want a specific date or
time printed on the notice, do not use
the Date or Time field, but rather type
it in the notice.
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[ Formatting Palette
Font

Alignment and Spacing
Document

Database Fields

1 September 2023
September 1st, 2023
Friday, September 1st, 2023
Sep 12023

Sep 123

09/01/2023

09/01/23

September 1, 2023

@ Formatting Palette
Font

Alignment and Spacing
Document

Database Fields

& category:
15:24
15:24:14

3:24:14 PM

3:24 PM

2023 CDM+ Users Conference



Inserting Page Breaks, Files, Text Borders, and Hyperlinks

CDM+ Notices have the ability to insert Page Breaks,
Files (text and graphics), and Text Boxes into the
body of the notice.

Page Break

Page Break

File...
Graphic from database...

Text Box

+V

Insert

ye

Find

Place your cursor where you want to add a page break, click the Insert button on the side of the Notice
window, and click on Page Break in the pop-up window.

paddle boats and. ot course, PIE [and burgers and dogs P LA
ond potato salad ond boked beans. . . you get the idea).

Poge b redk

To remove a Page Break, highlight it and press Delete on your keyboard.

Note: It is possible to insert Page Breaks into card and email notices, but they have no meaning for those reports.
It is recommended you only use Page Breaks in letter notices.

File

To insert a file:

1.

2
3.
4

Place your cursor where you want to add either a graphic (.jpg, .png, or .pcx) or text (.txt or .rtf) file.

Click the Insert button on the side of the Notice window.

Click on File in the pop-up window and select the type of file you wish to insert from the drop list.

Browse to select the file.

Select file

4 388 v = ™ My Screens

<>

Favorites

I
M Documents _ il g
[ Desktop
@ Recents star-wars- star-wars- star-wars-
backgro...s-04.jpg backgro...s-05.jpg backgro...s-06.jpg
0 Downloads

My Screens

A\ Applications

iCloud star-wars- star-wars- star-wars-
& iCloud Drive backgro...s-10.jpg backgro...s-11.jpg backgro...12-1.jpg
Locations ~
i —_— -
- Text Files *txt
e RTF Files *rtf
v JPEG Image *jpg
Portable Network Graphic *png
Options PCX Image *pcx

2023 CDM+ Users Conference
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star-wars- star-wars-
backgro...s-08.jpg backgro...s-09.jpg

star-wars- star-wars-
backgro...s-13.jpg backgro...s-14.jpg

= I

Cancel

Notices
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Graphic from Database

Selecting this Insert option allows you to insert a graphic from the CDM+ Graphic Browser. You can import
as many graphic files in the Graphic Browser as you like so that they are always readily at hand for use in
CDM+. Examples of graphics you might want to import include:

- ascan of the pastor’s signature

- agraphic of your church’s logo

The Graphic Browser is also used in name
badges, checks, and the yearbook directory, so SEEp sevevese eveses
images added to the graphic browser here are
available in all these locations. .

N
To insert a graphic from your CDM+ database: [ﬂﬁﬁ]
i | ANEW HOPE|
1. Place your cursor where you want to add o ltimEb N .
the graphic. 1| EEeRRIER | e

Dear Individual/First Name,

2. Click the Insert button on the side of the

You're invited to attend the annual church picnic Sunday, June 23,
following the 11 o'clock service. We'll have games for the kids, chances to

We hope to see

N Otl Ce \ n d OW- Sincerely, sign up for outreach opportunities, and a raffle to win dinner for four ata

local restaurant.

3. Clickon Graphicfrom database...inthe Sonuiches and vapy back ibs fom Barretts Sreckeovse, Plogss bring a
. . ~ side dish or dessert to share. ok
pop-up window. The Graphic Browser o hops 508 you thoret

will open. Sincerely

l\@u%%m

Dean Patterson

4. Choose an existing graphic from the
Thumbnails on the left side of the
Graphic Browser

5. Click OK.

To add a graphic file to the CDM+ Graphic Browser:

1. Clickthe Add button on the bottom of the Graphic Browser window or the Import button at the top
right of the Graphic Browser window.

2. Browse to find the graphic file, select it, and click Open.

Select a Photo to Import

< mv = My Screens

< Q

ma star-wars-pa...ounas- 18.Jpg
B star-wars-ba...ounds-19.jpg
@ Documents m star-wars-ba...nds-20-1.jpg
i star-wars-ba...ounds-23.jpg

Favorites

E Dessop = star-wars-ba...ounds-24.jpg

@ Recents = star-wars-ba...ounds-25.jpg

o Downloads m star-wars-ba...ounds-26.jpg

W8 star-wars-ba...ounds-27.jpg

E My Screens = star-wars-ba...ounds-28.jpg

A\ Applications m star-wars-ba...ounds-29.jpg

=4 star-wars-ba...ounds-30.jpg

iCloud = star-wars-ba...ounds-31.jpg

& iCloud Drive i star-wars-ba...ounds-32.jpg
= star-wars-ba...ounds-35.jpg YokohamaBridge.png

The graphic appears in the Graphic Browser window.
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3. Type a Description of the graphic.

[ ) @ Graphic Browser

Thumbnails Description:  Big City Image.jpg

2 Filename: YokohamaBridge.png

Location: /Users/hannah/Downloads/My Screens/
Size: 6.94in. x 3.90in. (753.7 KB)

Clear Import

summer-camp-clipart-0.jp¢

Church.jpg

invoice_overdue.png

Find: o Delete Add Close OK

4. Click OK.The new graphic will appear in your notice wherever you last placed the cursor.

NOTE: CDM+ will import all graphics at 96 dpi. If your original graphic was at a higher resolution, such as 300
dpi, you will notice the Size indicated on the Graphic Browser window after importing will be larger than the
original. Re-sizing the graphic back to the original size once you have placed it in the notice will return it to
a print-quality resolution of 300 dpi.

If you plan to use a graphic in Email Notices ONLY, you may wish to save it at the size you want at 96 dpi
resolution to avoid having to re-size it and ensure it will appear in email messages as you desire. However,
be aware that a 96 dpi graphic, when used full size, will NOT print well.

To remove a graphic from the Graphic Browser, select the thumbnail on the left and click the Delete button
at the bottom of the window.
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Formatting Inserted Graphics

Once you have inserted a graphic in the notice, either from a file or the database, you may format that graphic.

Click the graphic once to highlight it. Click the Format button on the side of the notice window and choose Picture
from the drop list. This opens the Format Picture window. You can also double-click the graphic to open this window.

Format Picture Format Picture
Wrapping Style Size
Height 2.00 Width 2.00
= Scale %
In line Wrap Behind Infrontof  Split Height 100 % Width 100 %
with text text text
. . Original size
In line text alignment i X
Height 2.00 Width 2.00
° Bottom Base Top Center
Space from text Lock aspect ratio
Top 0.00 Fixed Size
Left 0.00 Right 0.00
Bottom 0.00
% Revert Changes Cancel “ - Revert Changes Cancel “

Layout tab — Choose the Wrapping Style for your graphic by clicking on the appropriate icon. If you
choose to keep the graphic in line with the text of your notice, click a radio button to choose in line
alignment of the graphic.

The 4 fields under Space from text allow you to set a margin between your graphic and the surrounding text.

Size tab — Click the Size tab to adjust the sizing of the inserted graphic. You may either type a Height
and Width (in inches) or type a percentage to reduce or enlarge the graphic.

Warning! Enlarging a graphic may result in poor quality, depending on the resolution (dpi) of
the original graphic file. 300 dpi is the ideal resolution for printing graphics, though slightly lower
resolution graphics may be acceptable. A resolution of 72 to 96 dpi provides acceptable quality
for on-screen viewing (such as in an email ) ONLY. Since you are viewing the graphic on screen in

CDM+, we recommend you print a test copy of your letter or card to check it.

Clicking the checkbox next to Lock aspect ratio will prevent you from changing the proportions of the
graphic when you re-size it. If you check this box, type a number in the Height or Width fields, and press
tab, CDM+ will automatically enter the other proportionate dimension. This is a good way to make sure
you don't stretch photos and end up with distorted faces!

If the graphic is set to“In line with text” wrapping, you cannot drag it. Instead, cut and paste the graphic as if
it were a piece of text. For all other wrapping options, you can drag the graphic using the (left) mouse button.
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Data tab - In email notices, click the Data tab to add Alt Text to the images in the email notice. Alt
text should describe the image or its purpose in a few words. The alt text is displayed when the
recipient hovers over the image in the email.

Format Picture

Layout ‘ Size

Alt Text
Dean Patterson signature

% Revert Changes Cancel “

Alt text with images is important for accessibility and understanding. Recipients who are visually
impaired may use a text reader to read email content to them. The text reader will read the alt
text so that the recipient knows about and understands the image. Also, if for some reason the
image does not load for the recipient, the email client can display the alt text.

Helpful hint: Providing alt text with your images not only helps visually impaired readers, but it
also reduces the risk of the email notice going to their spam or junk folder.

Text Box

To insert a Text Box in your notice, place the cursor in the desired location, click the Insert button on the
right of the notice editor window and select Text Box.

Format Textbox

Size | Border and Background

Wrapping Style

N A = A A
In line Wrap Behind  In front of Split
with text text text
Space from text
Top 0.00
Left 0.00 Right 0.00
Bottom 0.00

it, Revert Changes Cancel ﬁ

Format Textbox

Layout m Border and Background

Size
Height 2.00 Width 2.00

Space between border and texti

Top 0.0
Left |0.10 Right | 0.10
Bottom | 0.10

% Revert Changes Cancel ﬁ

Layout tab — Functions the same as the Layout tab of the Format Picture window (see above).
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Size tab — Set the size of the text box in the top section of this window. You can also manually change
the size of a text box in the notice editor window by placing your cursor on the edges or corners, holding
down the (left) mouse button, and dragging.

The remaining 4 fields on this window set the amount the text is inset from the edges of a text box.

Border and Background tab — Use the radio buttons to select a Border Style and Line Style. If you wish
to create a text box with no border, for instance to place a caption under a photo, leave the Border Style as
None. With no Border Style chosen, the Line Style selected is immaterial.

Choose a color for the lines in the border by highlighting one of the color swatches in the Line Color list.
The Line Size sets the width of the lines in the border.

Highlight a color swatch and name in the Fill Color list to set the color of the text box fill (background).

Adding Hyperlinks

In email notices, you can set text in the email body to be a hyperlink to a web URL. In the Notice Editor, select
the text that should serve as the hyperlink. Click the Insert button, and choose Hyperlink from the list. This
will open the Insert Web Link window. You can modify the text in the notice by changing the Display Text
value. Enter the target URL for the hyperlink, being sure to include the http:// or https:// prefix. Add Tooltip
text. This text will display when the recipient hovers their cursor over the hyperlink text in the email.

When done, click the Insert button.

Helpful hint: Providing tooltip text helps reduce the risk that your email notice will go to the recipient’s
spam or junk folder.

Find and Replace Function

= °® Find and Replace | Ppalette

L Replace

ﬁ el | e CDM+ Notices include a find and replace
[ﬂ ] E] T - = function.You can search (and optionally replace)
the text in a Notice based on a particular word
Dear Individual/First Name,
e or phrase.

You're invited to attend the a Replace Al Replace (IS Find Next | Undo
following the 11 o'clock servi
sign up for outreach opport

local restaurant. — &

Dress code is casual. The church will be providing pulled pork BBQ
sandwiches and baby back ribs from Barrett’s Smokehouse. Please bring a
side dish or dessert to share.

We hope to see you there!

Sincerely,

Dean Patterson
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Dictionary and Spell Check

CDM+ Notices include an automatic Spell Check feature that works while you type so you'll never forget
to useiit.

The spell check system includes a Custom Dictionary to which you can add words, which the spell check
function “learns” so they won't be marked in all notices.

Words that are not in the spell check dictionary are marked with a red squiggle underline. Right-clicking (or
control-clicking on a Mac) on the suspect word brings up alternative suggestions, as well as options to Ignore
this instance of the word, Ignore All instances of the word, or Add the word to the Custom Dictionary.

. The church will be providing pulled pork BBQ

¢ back ribs from Barrett’s ©—-'-------~ RPlease bring a
o share. Barrett''s

Barrett's's
there! Barre’s’
Bartlet''s
Barrel”
Barrie"”
Barred"
Barren”
Barratr'’s
Barest”
Barer's'?
Barrels's
Barrier's

Ignore
Ignore all
Add
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